
Quick Start Guide To ExpressSCH

There are two parts to ExpressPCB, our CAD software and our board manufacturing 

service.  Our CAD software includes ExpressSCH for drawing schematics and 

ExpressPCB for designing circuit boards.  We also provide a low cost, high quality and 

fast source for having your boards made.  Here is how it works:
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1. We recommend that you begin by drawing a schematic using ExpressSCH.  

2. Next, use the ExpressPCB program to layout your PC board.  If you link your schematic to 

ExpressPCB, it will guide you through the wiring process.

3. When your layout is complete, determine the exact cost to have boards made with the 

Compute Board Cost command.

4. To order the boards, enter your name, address and billing information into ExpressPCB 

and press the Send button within the Order Boards Via The Internet dialog box.

5. In a few business days (typically 2 or 3) an overnight courier will deliver your PC boards.

Drawing a Schematic

ExpressSCH is a very easy to use 

Windows application for drawing 

schematics.  

While not required, we suggest that 

you draw a schematic for your circuit 

before designing the PC board.  By 

linking the schematic to the PCB, you 

will save time designing and be less 

likely to make mistakes.

You will also discover that the user 

interface for ExpressSCH and 

ExpressPCB is so similar that after 

spending the few minutes to learn 

one, the other will already be familiar.

The Side Toolbar

The toolbar along the left side of the ExpressSCH main window is used to select editing modes, such 

as place component and place wire.  These are the side toolbar buttons:

Tools for drawing the schematic Tools for creating custom components

Select, drag or set properties of an 

item in the schematic.

Draw a rectangle as part of a new 

component.

Zoom to view a selected area.
Draw a line as part of a new 

component.

Place a component in your 

schematic.

Draw a circle or an arc as part of a new 

component.

Place a symbol (such as GND or 

+5v) in your schematic.
Place a pin on a new component.



Wire components together. Draw text.

Insert a corner to bend an existing 

wire.

Disconnect a wire.

The Top Toolbar

When you click on a side toolbar button, additional buttons are added to the top toolbar, specific to 

the function selected.  Always displayed on top are these:

Open a schematic file. Zoom in. Zoom to previous size.

Save schematic file. Zoom out. Display Options dialog 

box.

Undo last operation. Zoom to see all. Display Component 

Manager dialog box.

When the Place Component button is selected on the side toolbar, these buttons are added on top.  

They are used to set the component's rotation before it is inserted into the schematic.

Place component body 

and text up.

Rotate component 

body down (text up).

Flip the component right 

to left.

Rotate component body 

left (text remains up).

Rotate component 

body right (text up).

 
Rotate component body 

and text left.

Rotate component 

body and text right.

Zooming and Panning

The easiest way to move around your schematic is with the scroll wheel on the mouse.  Turning the 

wheel zooms in and out.  Pressing the wheel and dragging the mouse pans.

The Grid

The Snap-to-grid is an invisible grid that helps you align wires and components.  With the 

Snap-to-grid on, you will notice that as you place objects, they gravitate to a grid boundary.  The 

Snap-to-grid spacing is set from the Options dialog box or from the Snap listbox located on the 

lower statusbar.  To toggle the Snap-to-grid on or off, press the G key or click .

Components and Symbols

You build a schematic by first placing components and symbols on the page and then wiring them 

together.  In ExpressSCH, components and symbols are different.  Components represent parts that 

you add to your circuit such as resistors and ICs. 

Symbols, such as these, are inserted into your schematic just like 

components.  However they differ from components in that they don't have a 

physical part associated with them.

Symbols are used to make electrical connections to common buses (such as ground) without having 

to draw wires.  They are also used to make connections from one page of a schematic to another.  

Here is how they work:  All symbols are assigned a NetName (such as GND).  Every symbol placed 

on a schematic with the same NetName is electrically connected together.  For example, every 

component pin that is wired to a ground symbol (which has the NetName GND) is connected.  Read 



Working with Sheets and Ports to learn more about Port symbols.

Beginning a New Schematic

1. Begin a new schematic by running ExpressSCH. 

2. Select New from the File menu and then choose the desired page size, typically Letter – 8.5" x 

11".  It is best to set the page size to the same dimensions as the paper in your printer.  By 

doing this, your schematic will be printed one-to-one.  If you create a schematic with a larger 

page size than in your printer, the printed schematic is compressed to fit the printer.

3. Fill in the text in the title block located in the lower right corner of the page.  Double click on 

"Company Name", "Schematic Name" and "Designer's Name" to set these fields.

4. Finally, give your schematic a filename by selecting Save As from the File menu.

Placing Components

Components represent parts that you will add to your circuit such as resistors and ICs.

The easiest way to place components 

in your board layout is to use the 

Component Manager.  

Tip:  Use the Find button to search for 

a component by its name.

To place a component:

1.   Click the  button located on 

the top toolbar to display the 

Component Manager.

 2. Select one of these categories:

•  Library components  -  Components that are included with the program

•  Custom components  -  Components that you have drawn

•  Favorite components  -  Components or symbols that you have book-marked

3. From the list box, choose the item to insert.  Note that the components list is organized by the 

prefixes:

•  Connector  -  connectors

•  IC  -  integrated circuits

•  Misc  -  batteries, buzzers and motors

•  Passive  -  resistors and capacitors

•  Semiconductors  -  transistors and diodes

4. Select how the component and its accompanying text are rotated by clicking one of:

 or to flip right-to-left pick .

5. Press the Insert into schematic button, then drag the component to the desired location.

6. Double click on the item just inserted to display its properties dialog box.  Here you will assign 

the component its Part ID (such as R1 or U1) and Part name (such as 74LS00 or 3.3K).

Placing Symbols and Ports - Using the Toolbars



Symbols such as these are inserted into your schematic just like components.  

However symbols are different from components in that they don't have a 

physical part associated with them.  To insert a symbol in to your schematic:

1. Select the 

 

  button from the side toolbar.

2. From the top toolbar, choose the symbol in the listbox as seen here:  

3. Move the mouse into the main window, press the left mouse button and drag the symbol to 

the desired location.

4. After placing a port symbol, assign it a NetName.  Do this by double 

clicking on it to display the Symbol properties dialog box.  The port 

symbol shown here has been assigned the NetName:  20 Mhz

Keep in mind that all symbols given the same NetName are electrically connected together on 

the schematic.  Read Working with Sheets and Ports to learn more about port symbols.

Wiring Components Together

1. From the side toolbar, select  or press the W shortcut key.

 2. Move the mouse to the wire's first end point and click left.  Typically you will start on the pin of 

a component.  Drag the wire to the second end point, then click left again.  Continue placing 

wire segments until you have reached the final end point.

3. While dragging the wire, the Del key deletes the previous segment, the + and - keys zoom in 

and out, the G key toggles the snap-to-grid on and off, the Spacebar sets the wire, and the 

Esc key cancels it.

4. To complete the operation, press the Spacebar or click right.

Working with Wires

Wires themselves cannot be moved.  The path of a wire is determined by the 

straight line between its two connections.  Therefore, to move a wire, you need 

to connect it to something different or to move what it is connected to.

Corners in wires allow them to bend.  They are displayed as small square 

blocks at the ends of wires.  A wire with two corners is shown here.  When you 

print your schematic, the corners will not be visible.

Corners can be dragged, inserted or deleted to change a wire's path.  To insert a corner, select 

 then click on the wire at the point where you want to insert it.

To disconnect a wire and reconnect it elsewhere, select  from the side toolbar.  Next, click on 

the wire near the point you want to disconnect, then drag the wire to a new pin.

Making Custom Schematic Components

ExpressSCH includes hundreds of components and symbols you can use in your schematics.  If you 

need something not included, you can easily build your own.  Here is how:

1. Begin by drawing the body of the component right in your schematic.  

Draw lines, rectangles and arcs by selecting these toolbar buttons:

 

             

Note:  Wires & corners should never be used when building 



components.

2. Next, place pins at the locations where wires will attach to the finished 

component by selecting  from the side toolbar and clicking at each 

endpoint.  Pins are shown as small circles on the screen, but will not be 

printed on the schematic.  We recommend setting the snap-to-grid to 

0.050" when positioning the pins.

3. After placing the pins, double-click on each to assign its pin number and 

pin name (i.e. CLR).  Then drag the pin number and name text to the 

desired locations.  We recommend selecting a text height of 0.060" and 

setting the snap-to-grid to 0.025" when positioning the text.

4. Group everything together to combine it into a single component as 

follows.  Select your new part by clicking  and then drag the mouse 

to enclose it.  From the Component menu, choose the command Group 

to make component.  In the Component properties dialog box, enter the 

Part name (i.e. 7474 or 3.3K) and assign it a Part ID (i.e. U1 or R12).

5. Save your new component to add it to the Custom components list.  Do this by selecting the 

part with the mouse and then choosing Save custom component from the Component menu.

FYI:  ExpressSCH stores every component and symbol listed in the Component Manager in its own 

file.  These files have the .S extension and are saved in the directories: 

•  Program Files\ExpressPCB\SchComponents_Library

•  Program Files\ExpressPCB\SchComponents_Custom

•  Program Files\ExpressPCB\SchSymbols_Library

•  Program Files\ExpressPCB\SchSymbols_Custom

Tip:  In many cases, it is fastest to build a new component by starting with a close fit from our 

library.  This is done by first inserting the library component into a schematic.  Next select it with 

the mouse and ungroup it using the Ungroup component command from the Component menu.  

Now make the desired changes as described above and finally regroup it back together to create 

the new part.  Your changes will NOT affect the original part in the ExpressSCH library.

Copying, Deleting and Moving Items

ExpressSCH uses standard Edit commands for Copy, Cut and Paste.  To copy an item or several 

items, first select them.  From the Edit menu choose Copy, then choose Paste.

Deleting items from your schematic is as easy as selecting them and pressing the Del key.

There are three ways most items can be moved.  Typically, items are moved by selecting and 

dragging them.  They also can be moved with the arrow keys by selecting them and then pressing 

Ctrl-right, Ctrl-left, Ctrl-up or Ctrl-down.  Alternately, an item can be moved by changing the 

coordinates set in its properties dialog box.

Tip:  To copy a group of items from one layout file to another, select and copy the 

items of interest into the clipboard.  Load the second file into ExpressSCH and paste.  

It is not possible to copy items between two programs running at the same time.



Working with Sheets and Ports

Schematics that have too many components to fit on a single page can be divided into two or more 

sheets.  When you print your schematic, each sheet will be printed on one page.  New schematics 

always start with a single sheet named Sheet1.  Additional sheets are added using the Add new 

sheet command from the Sheet menu.  To assign a sheet a meaningful name, select Rename this 

sheet from the same menu.

At the bottom left corner of ExpressSCH is a tab for each sheet in your schematic.  Shown here are 

the tabs from a schematic divided into three sheets:  CPU, Power Supply and I/O.

To switch between the sheets, click on one of the tabs.  The left and right arrows are used to scroll 

the tabs sideways should there be so many that not all can be shown.

When a circuit is divided into multiple sheets, a method is needed to make electrical connections 

between them.  This is done using Port symbols.

In this example, the output of the gate on the left is wired to a port symbol with the NetName 

Beep.  The input to the circuit on the right (which can be on the same or a different sheet) is also 

wired to a port with the NetName Beep.  This is the equivalent of running a wire between them.

Our library includes many port symbols to choose from.  To learn how to insert port symbols in your 

schematic, read Placing Symbols and Ports.

Checking for Errors

After completing your schematic, you should check it for errors before beginning your PC board 

layout.  Run the command Check schematic for netlist errors from the File menu.  This will check for 

problems such as components that have not been assigned a PartID, multiple components having 

the same PartID, and missing pin numbers.  

This command also scans for wires that are not properly connected and tries to correct them.  

None of the wires leading to the LED seen here are connected.  Wire 1 has 

not been dragged close enough to the LED's pin (shown as a dot).  Though 

wire 2 ends on the LED, it does not attach to the right place.  It needs to 

stop on the LED's pin.  The gray corner markers at the ends of wires 1 and 2 

indicate that they have not merged to the LED.  When a wire is properly 

connected to a component's pin, the gray corner marker will disappear.  The 

ground symbol (3) is also not connected.  The pin on the ground symbol is 

too far away from the pin on the LED to make a connection.

Note:  We strongly recommend that you visually inspect your schematic for errors 

before designing your PCB.  The Check schematic for netlist errors command only 

identifies a few types of mistakes that you might have made.  You should also make 

sure that all of your wires are properly connected to their components and other 

wires, because this command cannot fix all missed connections.

How to Contact Us

Please feel free to contact us if you have questions, comments or suggestions.  We can be reached 

by email at: support@expresspcb.com
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